About SecondChance

Welcome to PowerQuest SecondChance. Have you ever changed a system setting and found that it hindered the performance of your PC? Or
downloaded a file that caused problems for your system? Perhaps you have unsuccessfully tried to get rid of a program that only partially
installed? Or maybe you are not sure what happened to your system, but your PC just is not working as well as it worked yesterday?

SecondChance can return your computer to an earlier point in time, called a Checkpoint, when it was working to your satisfaction. You just
select the Checkpoint you want to return to, click a button, and SecondChance restores your computer to that Checkpoint. SecondChance is
also the perfect backup companion for imaging software such as PowerQuest Drive Image.

How Does SecondChance Work?

SecondChance creates Checkpoints, which are snapshots of your system at specific points in time. By default, SecondChance automatically
creates a Checkpoint once a day, Monday through Friday. You can change this schedule to meet your needs, and you can also create
Checkpoints manually at any time.

SecondChance runs in the background, automatically tracking any changes made on your system between Checkpoints. It saves copies of
files that are deleted or updated and records changes to directories. Because SecondChance is designed to minimally impact system
performance, you will hardly notice that it is running.

Whenever you want, you can restore your system to the state it was in at any previous Checkpoint in your list of Checkpoints. Before
restoring your system, you can use the SecondChance Checkpoint Viewer to see which folders and files have changed since the Checkpoint
you are restoring to was created.

Do not worry that your disk will fill up quickly with all of the files SecondChance is saving in Checkpoints. You determine how much disk
space to use for Checkpoints. SecondChance maintains the space limits you specify by automatically discarding the oldest Checkpoint when
necessary.

Disclaimer: Although SecondChance is easier and faster to use than standard backup software, it is not a replacement for such software.
SecondChance can help you recover from most but not all types of problems. For example, if your hard disk fails or becomes corrupted,
SecondChance may not be able to restore your system. Additionally, SecondChance does not track changes made to your system in MS-DOS
Mode or Windows Safe Mode. PowerQuest recommends using SecondChance together with standard backup software to cover those
problems that SecondChance does not handle.
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Getting Started

SecondChance starts automatically each time you start Microsoft Windows. It works in the background to monitor specified drives and track
changes that occur on your system between Checkpoints.

While SecondChance is running, you see the SecondChance program icon O on the Windows taskbar.
If you need to restore your system to a particular Checkpoint or change SecondChance settings, you can use the program icon to display the

SecondChance window.

When you installed SecondChance, you were prompted to create an Emergency Boot Disk. If you did not create the disk, you should create one
now. PowerQuest recommends that you create the disk before continuing. If you cannot restart your system or if Windows does not load properly,
you can use this disk to restore your system to a previous Checkpoint. Also, be sure you store the emergency boot disk in a safe place.

{button ,JI("',"To_open_the_SecondChance_window')} To open the SecondChance window



To create an emergency boot disk,

1
2
3
4
5
6

Insert a blank, formatted disk into your disk drive.
If necessary, open the SecondChance window.
Click the Options tab.

Click Create Emergency Disk.

Click Create Disk.

Click Done when the emergency boot disk is created.

Be sure you label the disk and store it in a safe place.
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To use the emergency boot disk,

Insert the emergency boot disk into the correct disk drive.

Restart your computer.

Use the Up or Down arrow key to select the Checkpoint you want to restore to.
Press <Enter> to start the restoration process.

Remove the emergency boot disk from the disk drive when prompted.
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Press any key to restart your computer.
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About the SecondChance Window

SecondChance works in the background to keep track of changes on your system between Checkpoints. When you want to restore your
system to a previous Checkpoint or customize how SecondChance works, you can display the SecondChance window.

The SecondChance window has one tab for each main task or group of tasks you can perform in the window. To display a tab, click the tab

name.

Tab name Description

Control Restore monitored
drives to selected

Checkpoints, manually
create a new

Checkpoint, and view a

drive as it was at a given
Checkpoint.

Options Add drives to
Checkpoint monitoring,
remove drives from
Checkpoint monitoring,
specify disk space
limits, and create an
Emergency Disk (if you
did not create one just
after you installed
SecondChance).

Checkpoint View a drive's

Space Checkpoint space and
delete old Checkpoints.

Schedule Schedule automatic
Checkpoints, view and
change the schedule.

Online Access the PowerQuest
Web site, download
SecondChance updates,
and get product

information.

{button ,JI("', To_open_the_SecondChance_window')} To open the SecondChance window

{button ,JI("',"To_create_an_emergency_boot_disk')} To create an emergency boot disk

{button ,JI("",'To_close_the_SecondChance_window')} To close the SecondChance window



To open the SecondChance window,

1 Locate the SecondChance program icon O on the Windows taskbar (near the time display).
2 Click the program icon.
Tips
®  You can also click Startk Programs
F  PowerQuest SecondChance, or you can right-click the program icon, then click Open SecondChance.
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To close the SecondChance window,

1 Click to close the SecondChance window.

The SecondChance program is minimized and appears in the icon tray on the Windows taskbar.

Tips
*  To close the SecondChance Checkpoint Viewer window, click File k Close.
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About Checkpoints

A Checkpoint is a snapshot of your system at a specific point in time. SecondChance saves a snapshot of your system configuration and all
the files on your computer when it creates a Checkpoint. You can schedule SecondChance to create Checkpoints automatically, and you can
also manually create a Checkpoint. It is a good idea to create a Checkpoint before you install or remove a product, download a file, or change

a system configuration setting. If something goes wrong, you can easily restore your computer to its previous state before the problem
occurred.

{button ,JI("',"To_create_a_Checkpoint_manually')} To create a Checkpoint manually



To create a Checkpoint manually,

Use the Control tab in the SecondChance window to create a new Checkpoint manually--usually before you install or remove a product,

download a file, or change a system configuration setting.

1 Click ( .

2 (optional) Type a Checkpoint description in the text box.
3 Click OK.

Tips
®  You can also right-click on the SecondChance icon in the Windows system tray, then click Create a new Checkpoint.
e  Checkpoints are always numbered sequentially (Checkpoint 1, Checkpoint 2, and so on).
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About Scheduling Automatic Checkpoints

By default, SecondChance is scheduled to create a Checkpoint automatically at 8:00 AM, Monday through Friday. Use the SecondChance
window's Schedule tab to change the default schedule to the day(s) and time(s) you specify. For example, you might want SecondChance to
create a Checkpoint at 6:00 PM, Monday through Saturday.

{button ,JI(*',"To_schedule_days")} To schedule days
{button ,JI("","To_schedule_times')} To schedule times

{button ,JI(*',"To_delete_a_scheduled_time")} To delete a scheduled time



To schedule days,

1 From the Schedule tab, select the day on which to create an automatic Checkpoint.

2 Repeat Step 1 for each day on which to schedule a Checkpoint.
Tips

e To leave a day unscheduled, leave its check box blank.
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To schedule times,

1 From the Schedule tab, click Add/Remove Times.
2 Type the time you want in the text box, then click Add.

3 Repeat Step 2 for each time at which to schedule an automatic Checkpoint.

Tips
e Instead of typing the time in step 2, you can select one from the list of time values, then click Add. Click the Up arrow button to select later
times; click the Down arrow button to select earlier times.

e To delete a scheduled time, select a time in the list box, then click Delete.
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To delete a scheduled time,

1 From the Schedule tab, click Add/Remove Times.
2 Select a time you want to delete from the list box, then click Delete.
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About Restoring Monitored Drives to Checkpoints
If something goes wrong and you need to restore your monitored drives to an earlier Checkpoint, you can use this basic procedure.
From the Control tab, select an earlier Checkpoint.

Use the Checkpoint Viewer to inspect the selected Checkpoint. You should inspect the Checkpoint first so you can compare the drive's
current state (the files and folders it contains, for example) to the way the drive looked when the Checkpoint was created.

Use the Restore button on the Control tab in the SecondChance window to restore your monitored drive(s) to the selected Checkpoint and
restart your computer.

{button ,JI(*',"To_select_a_Checkpoint')} To select a Checkpoint
{button ,JI("","To_inspect_a_selected_Checkpoint')} To inspect a selected Checkpoint
{button ,JI(*', To_restore_monitored_drives_to_an_earlier_Checkpoint')} To restore monitored drives

{button ,JI(*',"To_recover_current_files_not_restored_with_a_Checkpoint')} To recover current files and folders



To select a Checkpoint,

From the Control tab in the SecondChance window

1 Select the Checkpoint you want to view, from the list box.

From the SecondChance Checkpoint Viewer

1 Select the Checkpoint you want to view, from the Select Checkpoint drop-down list.
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To inspect a selected Checkpoint,

Before restoring a drive to a selected Checkpoint, you can inspect the Checkpoint to see what the drive looked like when the Checkpoint was
created. You can also see how the drive's current state differs from its state when the selected Checkpoint was created.

1 From the Control tab, click “ to open the SecondChance Checkpoint Viewer.
# Related Topics



To restore monitored drives to an earlier Checkpoint,

After inspecting the Checkpoint you want to use to restore your computer, use the Control tab in the SecondChance window to restore the
drive to that Checkpoint. When SecondChance restores your computer to an earlier Checkpoint, it automatically saves two new Checkpoints
on your drive--one created before you restore, and one created after you restore. The Checkpoint created before you restore ensures that you
can return your computer to the state it was in before you restored it to the earlier Checkpoint. The Checkpoint created after you restore is the
new starting point for SecondChance to track your changes.

1 Select a Checkpoint you want to restore.

2 Click o

3 Click Yes to confirm that you want to restore.
SecondChance checks the disk drive for errors before it starts to restore.

4 When prompted, quit all open programs, then click OK.

SecondChance creates a new Checkpoint, restarts your computer, and finishes restoring your system to the Checkpoint you selected. Then
it creates another Checkpoint.

5 Click Yes to use the Checkpoint viewer window to recover current data files and folders which are not saved in the Checkpoint to which
you restored your computer.

Tips
e Ifrestoring to this Checkpoint does not solve your problem, you can return to the Checkpoint created before you restored. Just select the
previous Checkpoint and repeat steps 2-5.

e If an error is found, use the Run ScanDisk program. Refer to your Microsoft Windows Help system for more information about using
ScanDisk.
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To recover current files not restored with a Checkpoint,

After restoring to an earlier Checkpoint, SecondChance gives you the opportunity to use the Checkpoint Viewer to recover current files that
did not exist when the earlier Checkpoint was created. By default, the viewer's Show Changes Only option is selected. This view makes it
easy for you to see exactly which folders and files have been added, modified, or deleted since the earlier Checkpoint was created.

You can also recover files and folders without restoring to a Checkpoint. For example, if you accidentally delete a folder, use the Checkpoint
Viewer to locate the folder in an earlier Checkpoint. Find the Checkpoint that was created when the folder existed. Then copy the folder to a
location on your disk drive, using the steps below.

1 In the upper-right pane of the Checkpoint Viewer, select the files and folders you want to restore.

2 Click File» Copy Selected Item(s).

3 Click Yes to copy the items to the same place where the items were located when the earlier Checkpoint was created, or click No to
open the file browser and select a new destination for the item(s).

Tips
e Instep 1, to select multiple adjacent items, press <Shift> and select the first and last items in the group you want.

To select multiple nonadjacent items, press <Ctrl> and select the items you want.

g
e Instep 2, you can also click on the toolbar.

*  You may have moved directories or changed directory names since the earlier Checkpoint was created. If so, use the file browser to locate
the new directory where you would like to copy the items.

®  Scenario - You want to restore your computer to the Checkpoint SecondChance took early this morning. Since that Checkpoint was
created, you have created a new spreadsheet. You restore your computer to this morning's Checkpoint, and you can no longer see your
spreadsheet file. You can not see it because it did not exist when the Checkpoint was created. Display the Checkpoint Viewer and locate
your spreadsheet file in the window's upper-right pane. Select the file and copy it where you want to keep it now.
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About the Checkpoint Viewer Window

Use the Checkpoint Viewer to inspect your Checkpoints before you restore your system to one of them. You can select a Checkpoint and
compare your system's state when the Checkpoint was created, with your system's current state. You can view and compare lists of color-
coded folders and files to see what has changed since the selected Checkpoint was created. The color-coding lets you quickly see whether
folders or files were created, deleted, renamed, or otherwise modified.

Folder Description

color

Gray No change
occurred

Green New folder was
created

Yellow Some change
occurred within
the folder

File

color

Blue File was
renamed, moved,
or otherwise
modified

Gray No change
occurred

Green New file was
created

Red File was deleted

The Checkpoint Viewer window displays,
e Atree view (or hierarchical list) of the folders in the Checkpoint (appears in the left pane of the window)
o Alist that reflects the content and status of the drive or folder you select in the tree view (appears in the upper-right pane of the window)

® Alist of the files and folders that were added after the selected Checkpoint was created (appears in the lower-right pane of the window)

{button ,JI(*',"To_open_the_Checkpoint_viewer_window')} To open the Checkpoint viewer window
{button ,JI("',"To_close_the_Checkpoint_viewer_window")} To close the Checkpoint viewer window
{button ,JI("","To_access_Help")} To access Help

{button ,JI(*',"To_use_the_toolbar")} To use the toolbar

{button ,JI("',"To_expand_and_collapse_the_tree_view')} To expand and collapse the tree view



To open the Checkpoint Viewer window,

1 From the Control tab, click LI
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To close the Checkpoint viewer window,
1 Click File n Close.
Tips
®  You can also click n in the upper-right corner of the window
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To access Help,
1 Click Help n Contents to display the online Help topics, or point to a toolbar to see a brief description of its use.
Tips

*  Help messages also appear in the status bar area at the bottom of the Checkpoint Viewer window. For example, when you point to a
SecondChance menu command, a brief description of its use appears in the status bar.

H Related Topics



To use the toolbar,

The toolbar is located below the menu bar near the top of the Checkpoint Viewer window. As you move your mouse over a tool, you will see
a brief description of its use. Except for Up One Level and Stop Current Operation, the toolbar commands are the same as the commands on
the Checkpoint Viewer's menus. The toolbar provides quicker access.

Click To
% | Refresh the view in the
window.
n Show only the files and
folders that changed.

To see the complete
view of files and
folders, click the
selected tool.

Show details about

r

changes to files.
SecondChance may
display two lines of
information for a
changed file. The top
line shows information
about the file at the
time the Checkpoint
was created; the
bottom line shows
information about the
current file on the disk
(current location of
moved files, current
name of renamed files,
and so on).

To hide change details,
click the selected tool.
Copy the items you
have selected. Use this
command to recover
accidentally deleted
items without restoring
to a Checkpoint, and to
recover items that are
not restored with a
Checkpoint.

Move up one level
from the folder

G

currently selected.

n Stop copying selected
item(s) or preparing a

view.
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To expand and collapse the tree view,
1 From the Checkpoint Viewer window, click the plus sign to expand a drive or folder list.
2 To collapse the list, click the minus sign.

3 To view more information about a folder, click the folder's icon in the window's left pane, or double-click the folder's icon in the window's
right pane.

4 To refresh the list, click View n Refresh View.
Tips
®  Anplussign next to a drive or folder icon in the left pane of the Checkpoint Viewer window indicates that you can expand the view to see
more entries.
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About Viewing Checkpoint Space

Use the Checkpoint Space tab to view information about the Checkpoint space allocations for the drive(s) that SecondChance is monitoring.
You can quickly see how much space is used and available.

SecondChance automatically discards old Checkpoints as needed to stay within the Checkpoint space limits you have specified for your
drive(s). You can also delete old Checkpoints manually, if you need to make disk space available. For example, if you did not have enough
room to install a new program, you could delete one or more selected Checkpoints manually. When you delete a Checkpoint in your list, all
prior Checkpoints are also deleted.

Disk Space

Because SecondChance saves deleted files in Checkpoints, you cannot increase your free disk space by deleting files and folders. You must
delete old Checkpoints instead. SecondChance maintains the space limits you set for the maximum disk space to use for Checkpoints and the
minimum disk space to keep free. To avoid exceeding these limits, SecondChance will discard your oldest Checkpoint. The more disk space
you allocate for Checkpoints, the more Checkpoints you can choose from when you want to restore your computer to an earlier state.

Increasing Disk Space

To increase your disk space, you can delete your oldest Checkpoint first (the Checkpoint with the lowest number). For example, if you have
Checkpoints numbered 1 through 10, delete Checkpoint 1 first. If you select Checkpoint 8 to delete, SecondChance displays a dialog box
informing you that deleting Checkpoint 8 also deletes Checkpoints 1 through 7. Because SecondChance maintains only the changes between
Checkpoints, if you delete Checkpoint 8, you can not restore your system to any earlier Checkpoint (1 through 7).

{button ,JI("',"To_delete_selected_Checkpoints')} To delete selected Checkpoints
{button ,JI(*',"To_change_space_limits_for_drives')} To change space limits for drives



To delete selected Checkpoints,

1 Click the Checkpoint Space tab.

2 Select one or more Checkpoints that you want to delete.
3 Click Delete Selected Checkpoint(s).

4 Click Yes to confirm the deletion.

Tips
*  SecondChance notifies you if earlier Checkpoints are associated with the Checkpoint you selected. Deleting the selected Checkpoint
deletes the previous Checkpoints as well.
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About Managing Checkpoints
Use the Options tab on the SecondChance window to manage Checkpoints. You can:

Specify the drives that you want SecondChance to monitor. You can only Checkpoint your physical disks; you can not Checkpoint
removable drives or network drives. If you have multiple partitions on your hard disk, SecondChance can monitor one or more of the
partitions.

Set limits on the use of disk space for Checkpoints and the number of days to keep Checkpoints.
Exclude directories from Checkpoints.
Choose whether you want to be notified before SecondChance automatically deletes the oldest Checkpoints.

The Options tab also gives you the ability to create an Emergency Boot Disk (if you did not create one when you first started SecondChance).
You can use the boot disk to restore your system to a previous Checkpoint, even if you cannot restart your system or if Windows does not load
properly. Once you create the boot disk, be sure you store it in a secure place.

{button ,JI("',"To_add_drives_to_Checkpoint_monitoring')} To add drives to Checkpoint monitoring

{button ,JI(*',"To_remove_drives_from_Checkpoint_monitoring')} To remove drives from Checkpoint monitoring
{button ,JI("',"To_change_space_limits_for_drives')} To change space limits for drives

{button ,JI(*', To_exclude_directories_from_Checkpoints')} To exclude directories from Checkpoints

{button ,JI("',"To_create_an_emergency_boot_disk')} To create an emergency disk

{button ,JI(*',"To_enable_Checkpoint_discard_notification')} To enable Checkpoint discard notification



To add drives to Checkpoint monitoring,

1 From the Options tab, click Drives.

2 Select the drive you want SecondChance to monitor.
3 Click OK.

When SecondChance notifies you that it must create a new Checkpoint and restart your computer before your changes can take effect, close
any open applications, then click Restart.
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To remove drives from Checkpoint monitoring,

1 From the Options tab, click Drives.
2 Deselect the drive you do not want SecondChance to monitor.
SecondChance warns you that removing the drive also deletes all of the Checkpoints on that drive.
3 Click OK.
When SecondChance notifies you that it must create a new Checkpoint and restart your computer before your changes can take effect, close

any open applications, then click Restart.
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To change space limits for drives,

When you installed SecondChance, it set default space limits for the drive(s) you specified for monitoring. You can change these limits for

disk space usage and the number of days to maintain old Checkpoints. To stay within the specified space limits, SecondChance automatically

discards old Checkpoints. SecondChance also warns you when you reach maximum disk space limits, unless you have disabled this feature.

1
2
3
4
5
6

From the Options tab, click Limits.

Select the drive you want to limit, from the Select Drive drop-down list.

Specify the Maximum Space for Checkpoints you want in the respective text box.
Specify the Minimum Free Space you want in the respective text box.

Specify the number of days (1-14) you want to maintain Checkpoints.

Click OK.

The new values take effect immediately.

Tips

In steps 3 and 4, instead of typing the space limit value, you can select one from the list of values. Click the Up arrow button to select
increasing values; click the Down arrow button to select decreasing values.

In step 5, SecondChance will not automatically discard Checkpoints created within the number of days you specified unless the amount of
free space on your drive drops below the minimum you specified in Step 4. In other words, for the number of days you specify,
SecondChance will ignore the setting in Maximum Space for Checkpoints. This will prevent recent Checkpoints from being discarded
when you uninstall a large application such as an Office suite (that is, unless you run out of disk space).
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To exclude directories from Checkpoints,

Use the Exclude button on the Options tab to exclude directories from Checkpoints. For example, you can exclude temporary directories
(such as \Tmp, \Temp, or \Windows\Temp) and Internet caches (such as \Temporary Internet Files) that consume space in Checkpoints and
need not be restored. You can add to the list of excluded directories. You can also remove directories from the list if you decide that you do
want them included in Checkpoints.

1 From the Options tab, click Exclude.

2 To specify a new directory to exclude, click Add Directory, browse for and select the directory you want to exclude from Checkpoints,
then click OK.

3 To remove a directory from the list of excluded directories, select the directory in the list box, then click Remove Directory.
4 Click OK.

When SecondChance notifies you that it must create a new Checkpoint and restart your computer before your changes can take effect, close
any open applications, then click Restart.
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To enable Checkpoint discard netification,

Use the Options tab to specify whether SecondChance will notify you before it automatically discards old Checkpoints. The oldest
Checkpoints are discarded so that Checkpoint space does not exceed your specified drive space limits.

By default, SecondChance notifies you before it discards old Checkpoints. If you do not want to be notified, you can change the default.
1 To enable Checkpoint Discard Notification, select the check box.

2 To disable Checkpoint Discard Notification, leave the check box blank.
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About Online Services

You can click the Online tab in the SecondChance window to visit the PowerQuest Web site (at http://www.powerquest.com). You can also
register your SecondChance software (if you did not register when you installed SecondChance), check for software updates, and update to a
newer version of SecondChance.

To use online services, you must have an Internet connection. You must also have a Web browser such as Netscape Navigator or Microsoft
Internet Explorer installed on your computer. SecondChance will automatically start your Internet connection software and display the Web
site that you choose.

{button ,JI("","To_register_SecondChance')} To register SecondChance
{button ,JI(*',"To_update_SecondChance')} To update SecondChance
{button ,JI(*',"To_view_the_PowerQuest_web_site')} To view the PowerQuest web site



To register SecondChance,

Registered users will receive free technical support and information on new product developments and upgrades as soon as they become
available.

1 From the Online tab, click the Register.
2 Follow the instructions on the registration page that appears in your web browser.
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To update SecondChance,
1 From the Online tab, click Update to connect to the PowerQuest web site and check for a newer version of SecondChance.

If a newer version exists, a dialog box asks you whether you want to download and automatically update your SecondChance software.
2 Click OK to download the new software version and automatically restart SecondChance.
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To view the PowerQuest web site,

On the PowerQuest Web site, you can get more information about SecondChance and other PowerQuest products, contact PowerQuest
technical support engineers, and buy additional products.

1 Click the www.powerquest.com button from the Online tab.
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About Quick Practice Lesson
You can complete this simple practice lesson to see how easy it is to use SecondChance. You will change the background image on your
computer desktop, then use SecondChance to restore your display exactly as it was before you changed it.
In this practice lesson you will do the following:
e  Take a Checkpoint before you change anything.
e SecondChance uses this Checkpoint to save a snapshot of your system configuration and your files.
®  Change your background display.
®  Return to your original background display. You will do this by restoring your computer to the Checkpoint you took before you changed
the display property.

ﬁl Take me through the lesson
{button ,JI("","To_create_a_Checkpoint')} To create the Checkpoint

{button ,JI("',"To_change_the_display_property')} To change the display property
{button ,JI("',"To_restore_a_drive_to_the_Checkpoint')} To restore the drive to the Checkpoint



To create a Checkpoint,

1 Click the Control tab in the SecondChance window.

2 Click “

3 In the Checkpoint Description text box, type Before display change.
4 Click OK to close the dialog box and create the Checkpoint.

The Checkpoint appears at the top of the list of Checkpoints, which is located at the bottom of the Control tab.

**| If vou have created the Checkpoint, you are ready to change the display property
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To change the display property,

1 From the Windows taskbar, click Start nSettings

n Control Panel.

2 Double-click Display, then click the Background tab.

3 Select a new wallpaper for the desktop, from the Wallpaper list box.
4 Click OK.

The background you selected now appears on the desktop.

**1 If you have changed the display property, you are ready to restore the drive to the Checkpoint you took earlier
Related Topics



To restore a drive to the Checkpoint,
Now you will return to your original display background by restoring the drive to the Checkpoint you took earlier.

1 From the Control tab, select the Checkpoint Before display change.

2 Click n

3 When prompted, click Yes to confirm that you want to restore your computer to the selected Checkpoint.

4 When prompted, quit any other programs you have open and click OK to restart your computer. It might take a while for your
computer to restart.

5 Log in when prompted and be comforted that your display looks exactly as it did when you started this practice lesson.

You will find SecondChance most useful when your system develops problems that interfere with your computer's performance. For example,
if your computer can not load Windows, you can use your SecondChance emergency boot disk. If changes to system settings cause trouble or
you get stuck installing or removing a program, you can restore your computer to an earlier Checkpoint.
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To remove SecondChance,

1 From the Windows taskbar, click Start n Settings

n Control Panel.

2 Double-click Add/Remove Programs.

3 From the Install/Uninstall tab, select SecondChance from the list box, then click Add/Remove.
4 Click Yes.
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PowerQuest Technical Support

Before Contacting Technical Support

PowerQuest is committed to providing you with comprehensive technical support. However, before contacting our technical support
department, please try to resolve your problem by using SecondChance Help, and PowerQuest’s corporate web site.

Tips
*  Your problem may be resolved by applying the most recent patch or upgrade of the software.

*  Your product serial number is required to obtain technical support.

Term of Technical Support for SecondChance 2.0
Technical support is available to all registered users throughout the life of SecondChance, which began when PowerQuest released
SecondChance 2.0 to manufacturing and ends six months after the release of SecondChance 3.0.

Upon registration, PowerQuest provides 90 days of complimentary technical support from the day of your first call. In addition, registered
users are eligible for special upgrade pricing when PowerQuest releases a new version of SecondChance. Contact PowerQuest Customer
Service for additional information about upgrade pricing.

Contact Information

E-mail
Language E-mail address (for
specific technical
problems)

Dutch eurots@powerquest.co

=

English help@powerquest.com
eurots@powerquest.co

=]

French france Q yowerquest.co

1B

German germany(@powerquest.c

om

Italian italian@powerquest.co

=]

Portuguese latina@powerquest.com
Spanish spanish@powerquest.co

=]

To obtain e-mail technical support for specific technical questions, you can fill out the form at
http://www.powerquest.com/support/emsupport.html.

E-mail on Demand
PowerQuest maintains an e-mail on demand system to resolve common problems. You can view a list of available documents at

http://www.powerquest.com/support/demand.html. To request one of the documents, send an e-mail message to support@powerquest.com
with the index number of the document in the subject of the message. You can only request one document per e-mail message.

Corporate Web Site

The PowerQuest web site includes a wide array of information, including answers to frequently asked questions.

Information Web Site Address



Overview of http://www.powerquest.com/
support options  support/index.html

E-mail support http://www.powerquest.com/
request form support/emsupport.html

Error messages http://www.powerquest.com/
support/er/er0000.html

SecondChance http://www.powerquest.com/

FAQs support/FAQs.html
Fax
Location Number
USA +1(801) 437-4218
Europe +31 (0) 20 582 9260

Fax a description of your problem to the technical support fax number. This service is available in the U.S., Canada, and Europe 24 hours a
day, 7 days a week. PowerQuest technicians try to respond to all fax requests within 24 hours.

Telephone
Language Location Number
Dutch Netherlands +31 (0) 20 581 3906
English Netherlands +31 (0) 20 581 3907
English UK +44 (0) 0171 341 55 17
English USA +1 (801) 226-6834
French France +33 (0) 169 32 49 30
German Germany +49 (0) 069 66 568 516
Italian Italy +39 (0) 02 45 28 1312
Portuguese USA +1 (801) 226-6834
Spanish Spain +34 (0) 91 622 3146
Spanish USA +1(801) 226-6834

The USA call center is open Monday through Friday, 7 a.m. to 6 p.m., MST/MDT. Our European call centers are open Monday through
Thursday, 9:00 to 18:00, CET, and Friday 9:00 to 17:00, CET.

Postal Service Mail

USA Europe
PowerQuest Corporation PowerQuest
P.O. Box 1911 Orlyplein 85
Orem, Utah 84059-1911 1043 DS
US.A. Amsterdam

The Netherlands

Please include a description of your problem. Also include a return address, a daytime phone number, or other relevant contact information.
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